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THIS PUBLICATION WAS PRODUCED BY THE JOINT TASK FORCE SPECTRUM 
MANAGEMENT COURSE. IT DOES NOT REFLECT ANY JOINT, SERVICE, 

COMPONENT OR TRAINING DOCTRINE, REGULATION, INSTRUCTION OR SOP. 
IT IS INTENDED TO BE USED ONLY AS A GUIDE TO HELP THE SPECTRUM 

MANAGER OR JCEOI AUTHORITY TO PRODUCE THE JCEOI AND LOADSETS.  
 
 
 

THIS PUB IS NOT LAW AND THE JTF COURSE IS NOT ACCOUNTABLE FOR 
RESULTS DUE TO USING THIS PUBLICATION.THIS PUB DOES NOT SUPERCEDE 
ANY OFFICIAL SOP, MEMORANDUM, REGULATION, OR INSTRUCTION ISSUED 

BY ANY COMMAND, COALITION, JTF, COCOM  OR UNIT AS TO HOW A 
JCEOI/LOADSET WILL BE PRODUCED. 

 
THIS REFERENCE IS BASED ON USING JACS VERSION 1.6. THE MAJORITY OF 

SELECTIONS/CHOICES AND DATA INPUT IS THE SAME WITH V1.5. SOME 
MENUS MAY HAVE CHANGED  
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JACS MENU MAP 
**Red Items are Right Click Options** 

 
 

ACES 

Remote Hosts 

Planning 

MISSION 

PLAN 

MNL 

RM 

SOI 

CNR

KEK Share Groups 

TEK Share Groups 

AFP Black Fill 

ARC210 Loadset 

SINCGARS Loadset 

Dictionaries

Groups

Short Titles

Call Sign Share 

Call Word Share 

Extract 

Extract Layer 

Frequency Separation 

Frequency Share 

RC>DTD File Download/Properties 

RC>New Mission 

RC>New Plan/Delete/Properties 

RC>Delete/Keys/DTD Download/Reports/Properties/Add Folders 

RC>Open/Delete/Reports/User Preferences 

RC>Create 

RC>New Short Title 

RC>Create 

RC>Create 

RC>Generate Hopsets/User Notes/Delete 

RC>Create 

RC>Create 

RC>Create 

RC>Open/Create MSRT/RAU Pairs/Delete/Reports/Generate 
CNR Hopsets 

RC>Delete/Suffix/Expander/Smoke/Pyro/Extract QR/master Call 
Sign/Pim 

RC>New Group

RC>New Group

RC>New Group

RC>New Group

RC>New Group

RC>New Group



 5

JACS Setup 
 

• After installing for the first time, ensure that the Unique Unit Identifier (UUI) is filled 
o Create Unique Unit Identifier (Used to provide unique key tag generation for each 

ACES Workstation) This HAS to be done in order to generate Key Tags/TSK’s 
etc… 

o Right Click on Globe > Properties>  
o This brings up JACS Properties 

̇ Unique Unit Identifier Tab 
• Enter Alpha Character, 4 Numbers 

o After entering the UUI, enter any user preferences pertaining to:  
̇ Default Folders Tab (The Default Folders user preference allows the user 

to set up the default planning folder(s) that will be created when a new 
plan is created. The creation of these folders is based on the currently 
installed modules. Only modules that are installed and have been setup up 
as a user's default folder in the user's preference will be created.) 

• For Joint use of JACS, select: 
o Resource Manager 
o Signal Operating Instructions 
o Master Net List 

̇ Combat Net Radio 
• All other folders are Army Unique Usage unless otherwise noted. 

̇  KEY Tags (The key tags user preference allows the user to set up the 
default key tag information that will be used in key creation and 
generation.) 

• DTD Download (The DTD Download user preference allows the 
user to set up the default key tag format, data transfer device type 
as well as the default DTD download folder that will be used in a 
DTD download operation.) 
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CREATE MISSION/PLAN/MASTER NET LIST 
 

1. Create New Mission/Plan 
a. Right Click on PLANNING>New Mission 

i. Enter Mission Name 
ii. Select Classification 

iii.  Enter any description 
b. Right Click on new MISSION>New Plan 

i. Enter Plan Name 
ii. Select Classification 

iii.  Enter the Crypto Effective Date, normally the begin date for the plan 
iv. Enter Duration Date, normally the length of the plan’s duration 

c. Add Folders if not set up in the Default Folders Tab of JACS Properties 
i. Right Click PLAN>Add Folders 
ii. Seelct folders needed. NOTE: FOR JACS, ONLY NEED: 

1. Resource Manager 
2. Signal Operating Instructions 
3. Master Net List 
4. Combat Net Radio 

2. Open Plan, expand folders into view. Right Click on MNL>OPEN 
3. Create a Master Net List (MNL) 

a. Enter Net Name, or Entity Name  i.e. ARFOR, AFFOR etc. 
b. Select Net Type from Drop Down Box 
c. Enter Frequency if fixed, or Frequency band. Can be typed in manually 
d. Add the following data if known, These are common information items that most 

Spectrum Managers use, but they are not the only ones to use: 
i. XSC Transmitter State/Country. SFAF Data Item Number 300.  
ii. XAL Transmitter Antenna Location. SFAF Data Item Number 301.  

iii.  EMS Emission Designator. SFAF Data Item Number 114.  
iv. PWR Transmitter Power. SFAF Data Item Number 115 
v. XLL Transmitter Antenna Coordinates. SFAF Data Item Number 

303 
vi. FREQ Sep 
vii. ORG Code 

viii.  Net ID Shows the Net Id. This field is editable and only applies to the 
CNR planning network 

ix. Chnl Space Shows the Channel Spacing. This field is editable. 
x. Cue Upper Limit Shows the Cue Upper Limit. This field is editable 

and only applies to the CNR planning network 
xi. C/S 
xii. C/W 

xiii.  EP ID 
e. Add any other information you need. 

4. Always VALIDATE/SAVE if given the option. If you attempt to select a menu option 
and it is grayed out, check to see if you have to VALIDATE/SAVE. 

5. In JACS v1.6, the user has the option to create a user defined view of the MNL, or select 
a pre-defined view i.e. ALL/CJTF/JTF, COMSEC, GROUPS etc. To create a user 
defined view, endure MNL is VALIDATED/SAVED.  
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a. Go to TOP MENUS 
b. Select MNL>User Views 
c. Name the new view 
d. Select whichever filed you want to include in the view. You can select fields that 

are the same as common SFAF items. 
 
 

CREATE RESOURCES 
 

1. After Plan and folders have been expanded, Right Click on RM>OPEN 
2. Right Click on screen and select NEW 
3. In the ATTRIBUTES Tab fill in: 

a. Resource Name:  Name identifying the Emitters i.e. LMR etc… 
b. Resource Type:  Recommendation is to change to SOI. If it is not at 

SOI then JACS will not marry the resource to the nets during the FREQ Analysis 
and/or Generation of JCEOI. If the resource is specifically for Hopset/MSRT 
Pairs, then leave as RAW at this time. 

c. Transmit State/Country Location: Enter the SFAF Item 300/XSC data from the 
nets in MNL that will be using this resource 

d. Transmit Antenna Location: Enter the SFAF Item301/XAL data from the nets in 
the MNL that will be using this resource 

e. Station Class:   Enter the Station Class of the nets in the MNL that 
will be using this resource 

f. Transmitter Power:  Enter the Transmitter Power of the nets in the MNL 
that will be using this resource   

g. Emission Designator:  Enter the Emission Designator of the nets in the 
MNL that will be using this resource 
****NOTE: THE EMISSION DATA ENTERED INTO THE RESOURCE 
ATTRIBUTES MUST BE VERBATIM AS IT IS IN THE MNL FOR THE 

NETS USING THIS RESOURCE OR ELSE AN ERROR WILL BE 
GENERATED DURING JCEOI GENERATION*** 

4. In the Frequency List Tab fill in: 
a. Start Freq: M32.00 
b. Stop Freq: M33.50 
c. Increment: K25 
d. Then hit the Add Range button. 

5. The Frequency Map shows the layout of all the frequencies and number of frequencies 
6. The Statistics Tab gives stats pertaining to the resource just created 
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CREATE SUFFIX/EXPANDER, SIGN/COUNTERSIGN, SMOKE/PYRO, EXTRACT 
PACKET QUICK REFERENCE 

 
Suffix/Expander 

1. Right Click on SOI>Suffix/Expander 
2. Use the default Suffix titles in the 1-17 column, or import a predetermined list. In the 18-

20 column, enter the suffix for the title i.e.  
a. COMMANDER 06 
b. XO   03 
c. 1SG/CSM  07 

3. Select the Expander tab and use the default Expanders in column 1-18 or import a 
predetermined list. In the 19-20 column, enter the expander for the title i.e. 

a. COPILOT  X 
b. FORWARD  B 
c. MAIN   C 
d. DRIVER  W 

 
Sign/Countersign 

1. To create a predefined S/CS list, Right Click on SOI>Sign/Countersign 
2. Select a dictionary to use from the drop down window, if available. 
3. If there is no dictionary, type in 20 random words that have no relationship to each other. 

They can only be between 2-10 characters in length. If you want JACS to randomly pick 
S/CS, then you must create that dictionary in later steps. 

 
Smoke/Pyro 

1. To create predefined smoke meanings, Right Click on SOI>Smoke/Pyro 
2. In the predefined smoke menu, highlight the colored smoke, then highlight the meaning 

of the smoke. While both smoke and meaning are highlighted, select the “Accept Smoke 
Pair” button on the bottom. Do this for all the smoke pairs to be defined. 

3. To create predefined pyro meanings, Right Click on SOI>Smoke/Pyro 
4. In the predefined pyro menu, highlight the colored pyro, then highlight the meaning of 

the pyro. While both pyro and meaning are highlighted, select the “Accept Pyro Pair” 
button on the bottom. Do this for all the pyro pairs to be defined. 

 
Extract Packet Quick Reference 

1. ACES allows you to create the Quick Reference pages to be included in the Extract 
Packet and Master Call Sign Book. These Quick Reference pages can be included in the 
Extract Packet and Master Call Sign Book when they are being created. When you are 
creating the Extract Packet Quick Reference pages, the current working page number will 
appear in the lower right of the ACES main screen. The page numbers are important 
because during the SOI packet creation, these page numbers are used to identify the 
pages required to be included in the packet. 

2. To create the extract packet quick reference, Right Click >SOI>Extract Packet Quick 
Reference. 

3. In the Packet Quick Reference Edit window, type in the desired information.  
4. When you have finished typing, select File>Save from the menu to save all pages. Once 

the Save option has been selected, the Extract Quick Reference pages will be saved and 
you can include these pages in the SOI packet during the SOI packet creation. 
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CREATE DICTIONARIES 

1. To create a new dictionary, expand SOI, Right Click >Dictionaries>New Dictionary 
2. Type in the dictionary name 
3. Select the type of dictionary. All dictionaries are created the same way. 
4. Either manually type words into the dictionary or import words in from a .TXT file. 
5. Dictionaries must meet the following criteria: 

a. 15 Char CW Dictionary 6-15 characters 
b. 5 Char CW Dictionary 2-5 characters 
c. CW User Defined Dictionary 2-15 characters 
d. Color Words Dictionary 2-16 characters 
e. S/CS Dictionary  2-10 characters 

6. If importing a text file, you will receive an error if all words do not meet the above 
criteria plus: 

a. Invalid character on a specific line number 
b. Characters exceed maximum length for the dictionary creating 
c. Characters do not meet the required length for the dictionary creating 

7. If a net has a fixed call word in the MNL, the word must be in the dictionary that is 
selected during the generation process. 

 
CREATING GROUPS 

To the various type of groups, expand SOI>Groups and select from the following: 
a. Call Sign Share Group 
b. Call Word Share Group 
c. Extract Group 
d. Extract Layer 
e. Frequency Separation Group 
f. Frequency Share Group 

Call Sign Share Group 
1. Right Click >Call Sign Share>New Group 
2. Type in the name of the group 

 
Call Word Share Group 

1. Right Click >Call Word Share>New Group 
2. Type in the name of the group 

 
Extract Group (An Extract Group identifies the nets that will appear on the same extract 
of an SOI packet) 

1. Right Click >Extract>New Group  
2. On the General tab, enter the name of the group 
3. Select Extract Group Tab 

a. Select the format of the group 
b. Select the nets that you want to appear on this extract of an SOI packet by 

clicking the desired net in the Available Nets box; the selected net's border 
becomes bolded. Move the mouse cursor until the arrow with a small gray box 
appears. Once the arrow with a small box appears, hold down the left mouse. 
While holding down the left mouse, drag the selected net to the desired Net Name 
cell in the Group Contents box and drop the selected net in the desired Net Name 
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cell. The selected net appears in the Group Contents box. You can also enter the 
MNL line number in the desired MNL Line cell and click the mouse cursor into 
the next row to select the desired net.  

 
Extract Layer 
(An Extract Layer identifies the Extract groups that will appear together in an SOI packet. 
The line represents the line position that the group will appear in the layer.) 

1. Right Click >Extract Layer>New Layer 
2. Enter a unique name for the layer 
3. Any unassigned extract groups will appear in the Unassigned Extracts window 
4. Select the groups that you want to appear in this layer of an SOI packet by clicking the 

desired group in the Unassigned Extracts box; the selected group's border becomes 
bolded. Move the mouse cursor until the arrow with a small gray box appears. Once the 
arrow with a small box appears, hold down the left mouse. While holding down the left 
mouse, drag the selected group to the desired Group Name cell in the Layer Contents box 
and drop the selected group in the desired Layer Name cell. The selected group appears 
in the Layer Contents box 

 
Frequency Separation Group 

1. Right Click >Frequency Separation>New Group 
2. Enter the name of the group 
3. On the Frequencies tab: 

a. In the Minimum Frequency field, enter the minimum frequency separation that is 
acceptable; the ‘What I will accept” frequency 

b. In the Desired Frequency field, enter the frequency separation that is desirable, if 
possible; the “Wish List” frequency separation 

 
Frequency Share Group 

1. Right Click >Frequency Share>New Group 
2. Enter the name of the new frequency share group 

 
Short Titles 

1. Right Click >Short Title>New Short Title 
2. Enter Short Title name 
 

Generate Editions 
1. Expand to the Short Title just created 
2. Right Click >on the short title>New Edition 
3. Enter the following info: 

a. Alpha Character A- ZZ 
b. Classification 
c. Any description 
d. Select create to generate the edition and leave the window open to create more 

editions. Suggestion is to create 3 editions. A edition for issue and use, B edition 
on the shelf in case A gets compromised, and C on the back shelf if B goes active. 
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CREATE FREQUENCY ANALYSIS OF MASTER NET LIST 

This operation calculates the number of SOI frequencies, which will be required to meet the 
current MNL requirements. This operation takes into account the number of frequencies 
matching the required SOI frequency generation requirements, which are already contained in 
the MNL.  
JACS, as a default only produces a SFAF from the Frequency Analysis with the following items, 
if they are filled out in the MNL: 

1. 005  010 
2. 102  110 
3. 113  114 
4. 115  140 
5. 141  144 
6. 300  301 
7. 502  803 
8. 804  910 
To add other line items to the SFAF: 
1. Right Click >MNL>User Preferences 
2. Select SFAF Proposal Tab 
3. Check the line item numbers that are to be included in the SFAF proposal that JACS will 

create 
To create the Frequency Proposal and SFAF: 

1. Open the MNL 
2. Select MNL>SOI>Frequency Analysis from the top menu 
3. The frequency analysis results will be displayed in a standard view where the SFAF 

hierarchy (STC, XSC, XAL, EMS, PWR and DOR), Channel Space and Frequency Band 
will be displayed in a table format. The expanded view will display all of the items in the 
standard view plus the selected extended SFAF attributes 

4. The end result is to have dashes in the Freqs Needed for all the bands listed. 
5. If there are frequencies needed, create a SFAF proposal: 

a. Select SFAF>Create Proposal 
b. In the Generate SFAF Proposal window, select the browse button, path to where 

the file will be saved and name the file 
c. Enter the requestors name 
d. Select Full or Compressed from the format options 
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STEPS AFTER CREATING JACS SFAF PROPOSAL 
1. Import JACS SFAF Proposal into SXXI 
2. Nominate and create assignments off of the JACS Proposal 
3. Export assignments in single column SFAF format 
4. Import these assignments into JACS, into the plan that is being used 
5. Import from PLAN>PLAN, or RM>PLAN 
6. Go into JACS 

 
REPLICATE SFAF COLUMNS  

(This Replicating the SFAF Columns operation is used to automatically populate all nets that 
share the same Classification, XSC, XAL, STC, EMS, PWR, and DOR as the selected net with 
the same SFAF data assigned to the selected net. The Full classification of a net is used in the 
matching criteria.Any NIU data created from this import will be at the end of the MNL named 
DEFAULT NET X. There may be more than one entry. 

1. Highlight however many of the DEFAULT nets were created 
2. Select NET>Replicate SFAF Columns 

a. Choose: 
i. Replicate all columns: Updates matching nets with the exact same data 

as the master net. This includes clearing cells on matched nets that 
correspond to a blank master net cell and overwriting filled in data on 
the matched net with data from the master net. 

ii. Replicate all filled in columns: Will only overwrite data in matched nets 
cells for cells the master net has data 

iii.  Merge-fill in blanks: Will not overwrite any data for the matched net and 
also fill in data for empty cells corresponding to cells that have data in 
the master net. 

b. After replication is done, delete all DEFAULT nets 
3. Go into RM 

a. Rename any of the new resources that were imported from SXXI 
b. Change those resources from RAW to SOI. If left in RAW, JACS will not use 

those resources during the generation process 
 

NET IDs/EP IDs 
1. Net Ids 

a. Sort MNL by Net Type. SINCGARS nets will be at top 
b. Ensure that all SINCGARS nets have a 3 digit Net ID, a single digit and XX or 

XXX. Any X in the Net ID column will be randomly generated by JACS. 
2. EP Ids 

a. Place a 1 in the EP ID column for all SINCGARS nets that will be using the 
SAME TSK and HOPSET resource 

b. By using different EP ID’s, multiple TSKs can be used while using the same 
HOPSET 

 



 13

GENERATE JCEOI 
1. After all frequency requirements have been fulfilled, verified by using the frequency 

analysis, proceed to generate the JCEOI 
2. If MNL needs to be validated and/or saved, do so at this time 
3. To do a Pre-Gen Analysis, on the MNL, select the nets to be generated by highlighting 

their entire row 
4. At the top menu, select MNL>SOI>Pre-Gen 
5. Select whatever components to be run thru the analysis, the select OK 
6. Not all warnings/errors will be found during the pre-gen. Warnings can be lived with but 

all errors must be fixed before generation 
7. After pre-gen has been run (optional), to generate, on the MNL, select the nets to be 

generated by highlighting their entire row 
8. Either select the G at the top of the MNL, or at the top menu, select NET>SOI 
This section provides you with the information on how to generate an SOI.  

 
GENERATION INFORMATION 

ACES allows the operator to generate selected components of SOI. Additionally, the operator 
can generate SOI for a selected group of nets.  
Components can be individually selected to be generated including Suffixes/Expanders, Net 
IDs, Frequencies, Colorwords, Call Words, and Call Signs.  
Additionally, the operator can select to generate Smoke, Pyro, Signs/Countersigns, Running 
Passwords, and PIM Codes using a random assignment performed by the software or using 
the assignments already created by the operator (predefined). When using random 
assignments for Signs/Countersigns and Running Passwords, a dictionary must be selected 
from which the assignments will be generated.  
When generating a new SOI edition, only the Unassigned Fixed option is selectable.  
 
When performing generation for a previously generated edition, Replace Existing 
Generated Data for Selected Nets and/or Update Generated Edition and/or Unassigned 
Fixed options are selectable.  
 
Replace Existing Generated Data for Selected Nets option generates new assignments for 
the selected nets regardless whether generated data has been previously assigned to the nets. 
When this option is not selected, existing generated assignments will not be replaced even for 
selected nets.  
 
Update Generated Edition option updates the selected SOI edition with the current planned 
Extract Groups. During the update, Last Letter Uniqueness (LLU) will be validated.  
 
Unassigned Fixed option randomly assigns a fixed frequency and/or fixed call word and/or 
fixed call sign to the selected nets.  
 
Update ALE Data option updates the data of ALE. 
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SINCGARS NET UNIQUE FUNCTIONS 

After all frequency requirements have been fulfilled certain tasks must be accomplished for 
SINCGARS nets. These tasks are not needed to generate a JCEOI, but it is easy to do at this time 

1. HOPSETs should be created 
2. TEK/KEK share groups created 
3. EP ID Groups must be created 
4. Crypto (TSK, Key Tags) generated 
5. LOADSET created 
 

HOPSET 
1. Go to MNL>CNR 
2. Right Click >CNR>Generate Hopset 
3. In Resource filed, use drop down menu to select resource to be used from the RM. The 

resource to be used for Hopset Generation MUS BE IN RAW  
4. Select Target Definition from the drop down menu. Frequency Hopping (FH) memory 

channel. There are six FH memory channels in the RT-1523. Each net definition is 
capable of storing a limited amount of FH data. Each Target (Net) Definition can hold a 
maximum of 16 words of memory. The words compose the FH data necessary for the 
SINCGARS radio to frequency hop. Net definitions contain a limited amount of local 
lockout capability. During the ACES Generation of Hopsets, you must select the Target 
(Net) Definitions for the Hopsets. You will have the following options 

a. Net Def: Net Defined1-16 words, resident memory lockout space 
b. Net Def + L7: Net Defined with Lockout 7 - 17-40 words 
c. Net Def + L7 + L8: Net Defined with Lockouts 7 and 8 - 40-64 words 
d. Common: Common lockouts which are common restrictions to all six channels in 

the radio. These lockouts are referred to as L1 through L6. This option is rarely 
used because it causes interoperability problems between two radios using 
different common lockout sets or not using common lockouts.. 

e. There are other pros/cons to selecting from these options that the JACS operator 
must understand 

5. Name the Hopset to be generated 
6. Select Generate. Number of Frequencies in Hopset using the selected Net Definition will 

be displayed 
7. Select OK. New resource will be in the RM with above name and the type of resource 

being SINCGARS HOPSET 
 

TEK/KEK Share Groups 
1. By creating these share groups, and placing SINCGARS nets into these share groups, the 

same TEK/KEK key tag will be generated for all these nets rather than different key tags 
for each SINCGARS net. This allows for the same TEK/KEK to be issued to all the 
SINCGARS nets 

2. Creating TEK and KEK share groups are done the same way  
a. Under MNL>CNR>TEK Share Group, Right Click >TEK Share Group>Create 
b. Name the share group 
c. Select CREATE to create the share group and leave the window open or select 

OK to create the group and close the window 
d. Open the ML and change the view to COMSEC 
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e. Sort the MNL on Net Type to bring all SINCGARS nets to top 
f. In TEK Share Group, select the group using the drop down menu and place the 

SINCGARS nets into the appropriate groups. Do the same with KEK Share 
Groups 

 
Crypto/Key Tag Validation and Generation 

1. Crypto Generate and validate: 
a. With the MNL sorted on Net Type, highlight all SINCGARS nets. 
b. Select NET>Crypto-Generate. If this option is grayed out, MNL may have to be 

validated and/or saved 
c. In the Generate field of the Crypto-Generate menu, select EP/Key Assignments 

and Tags 
d. In the Key field, select the Source and the classification of the tag 
e. In the Time Space, select the Start date and End date 
f. Select Generate and read any prompts 
g. After Successful Generation message is displayed, select CANCEL to close the 

window.  
h. Using this method, TSKs will be generated.  

2. Option 2  
a. To generate EP definitions (EP Share Groups) 

i. Go to MNL>EP Definitions 
ii. At top of EP Share Group Window, select Keys>Create SINCGARS TSK 

Key 
iii.  In Text ID Field, enter name of TSK 
iv. Select Key Classification from drop down menu 
v. Select Cryptoperiod from drop down menu 

vi. Select Key Tag Classification from drop down menu 
vii. Select Effective Date 

viii.  On EDITIONS Tab, select Add Edition for however many editions needed 
to be generated 

ix. Select OK to close menu 
b. Back in EP Share Group Menu: 

i. Select CNR from net type 
ii. Select the HOPSET resource that will be used. 

iii.  Select the TSK just created in the Key Field. If the key is not visible, close 
the EP Share Group menu, then go back into it 

 
LOADSET Creation 

1. Path MNL>CNR>SINCGARS Loadset 
2. Right Click SINCGARS Loadset>Create 
3. In SINCGARS Loadset Tab: 

a. Name the Loadset 
b. Enter the Mission Start Date 
c. Select the Short Title 
d. Select the edition 

4. Before going to the Channels Tab, open the MNL and sort on Net Type to bring all 
SINCGARS nets to top 
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a. Type in the MNL Line number of the Net to be included in the Loadset in line 1-6 
of the channels 

b. All columns should automatically get filled out 
c. Select Create to CREATE one and leave the window open, or select OK to create 

on and close the window 
 

PLATFORM, EQUIPMENT, DISTRIBUTION Paths Creation for CT3 Download 
1. In order for the LOADSET and JCEOI to be loaded into a DTD that is loaded with CT3 

software, PLATFORMS, EQUIPMENT and Distribution Paths must be created for all 
SINGCARS nets. 

2. On the MNL, highlight the first SINCGARS net, Right Click, and select OPEN. 
3. On the PLATFORM Window, Right Click in the filed and select NEW. 
4. Type in the platform name i.e., NCOIC, OIC 1SG etc, This must be a unique name and 

cannot be empty. 
5. In the DISTRIBUTION PATH field, enter the distribution path. One naming convention 

can be the Higher Echelon of the net. This naming convention should be simple. See 
below: 

To avoid confusion it is important to use unique names for platforms and 
equipment, and also to follow some standard naming conventions for distribution paths. 
SOPs developed by local signal units should take precedence over this ACES Online 
Operator's Manual. Following are some naming convention suggestions.  
 
Distribution Paths  
 
The Distribution Path or Path Name is a text string of alphanumeric characters used in 
certain ACES screens (e.g, New GP Platform Properties Window, GP Platform 
Properties Window, CNR Add Platform Window). This Path Name is the mechanism 
used to simplify the distribution of sets of data from the ACES Workstation to the DTD 
and then from DTD to DTD. Proper distribution path planning will allow the DTD 
operator at a higher echelon to quickly select sets of data to transfer to lower echelon 
DTDs  
 
Using standard naming conventions for the distribution path will help avoid confusion. 
One recommended format is:  

Unit Designation of 
Highest Echelon 
DTD 

+ 

Unit Designation 
of 
Next Echelon 
DTD 

+

Unit Designation 
of 

Next Echelon 
DTD 

...  

Unit Designation 
of 
Lowest Echelon 
DTD 

 
 
Some example distribution paths might be 1BDE3BNACO1PLT or 82DIV1BDE. 
 
6. Click or tab the cursor into the Platform Role drop-down box. Select the appropriate 

platform role by clicking the down arrow and selecting one of the available roles from the 
drop-down list.  
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NOTE: Only one NCS and ALT is allowed per CNR net and there must be at least one 
role selected. 

 
 
 
 

New CNR Platform Properties Property Sheet - Field Descriptions 
 

Platform 
Name: 

The unique name for the functional element to which one or more equipments 
are assigned. This field is modifiable. 

Distribution 
Path: 

A text string which simplifies distribution of groups of data from the ACES 
Workstation to a DTD, and from DTD to DTD. 

Platform Role: Choose a role from ALT, NCS or SUB.  
NOTE: Only one ALT and one NCS can exist per CNR network.  

NCS Net Control Station 

ALT Alternate NCS 

SUB Subscriber  

7. The next step is to create equipment for a CNR platform. Open the desired platform, 
either by selecting Platform Open on the menu bar at the top of the main ACES 
window or Right Click and choosing Open from the context menu. Once the Open 
option is selected, the platform is opened and displays the list of equipments if any 
equipments exist under this CNR platform. Once the desired CNR platform is opened, 
perform the following steps to create CNR equipment. 

8.  Either select Equipment New on the menu bar at the top of the main ACES window or 
Right Click and choose New from the context menu. The New CNR Equipment 
Properties Property Sheet appears with the cursor in the Name box. 

9. Type in the equipment name.  
NOTE: This equipment name must be unique for the entire plan and this box cannot be 
empty.  

10. Click or tab the cursor into the Type drop-down box. Select the appropriate equipment 
type by clicking the down arrow and selecting one of the available types from the drop-
down list.  
NOTE: The available equipment types are based on the frequency of the net that was 
selected when the net was added to the MNL.  

11. When you have finished entering and selecting information, click the appropriate button 
to complete the operation. 
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New CNR Equipment Properties Property Sheet- Field Descriptions 

 

 

Name: The unique name for the functional position associated with an assemblage of 
equipments (not the person filling that position). The name must be unique to the 
platform and to the plan. This field is modifiable. 

Type: Type of equipment used to secure the net. The available types are based on the 
frequency band of the net 
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MASTER NET LIST FIELD DESCRIPTIONS 
 
 

AGN C/S C/W C/S Share C/W Share Chnl Spc 

Clr/Num Clr/W COMSEC 
Class 

Coord CRKT Cue Upper 
Limit 

EMS EP ID FRQ FRQ 
BAND 

FRQ Sep FRQ Share 

Guard Group ICOM Hopset JRFL KEK KEK Share 

Keymat Line NATO Pool Net ID Net Name Net Status 

Net Type NonICOM 
Hopset 

Notes Org Code Platform 
KEK 

Proj Name 

PUSH PWR Rad Tun RAL Restore RENT 

Reuse Cls Reuse Pri Reuse Zn RLL RORB RORBAP 

RORBIN RORBNR RORBPE Rrad RRNT RSC 

RSNT Sec Class Spc Inst Status Date STC TAD 

TEK TEK Share Text Usage User User Code 

XAL Xeqp XLL XORB XORBAP XORBIN 

XORBNR XORBPE Xrad XSC XSPD 24HR 

 

Sec Class Security Classification. SFAF Data Item Number 005. Data Item 005 has two 
parts. Part one contains a 2-letter designator representing the security classification 
of the record and, if applicable, special handling instructions. The second part of the 
item contains a 10-character field containing the record declassification 
instructions. The record declassification instructions must always be entered if the 
first character of the security classification is a C, S, or T.  
 
Classification Codes - First Character  
 
U - UNCLASSIFIED   C - CONFIDENTIAL   S - SECRET   T - TOP SECRET  
 
Special Handling Codes - Second Character  
 
Special Handling Codes may be required in TOP SECRET, SECRET, or 
CONFIDENTIAL records to reflect the fact that if the classified data were removed 
from the record, the remaining UNCLASSIFIED data must still be protected in 
accordance with the applicable special handling code. Remember, this could apply 
in instances where SECRET or CONFIDENTIAL records are sent to NTIA as 
UNCLASSIFIED records for inclusion in the GMF automated database.  

A Approved for public release; distribution is unlimited (DoD Directive 
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5230.24). 

B Releasable to soil country and the North Atlantic Treaty Organization 
(NATO); otherwise, not releasable outside the US Government in 
accordance with (IAW) Section 552(b)(1) of Title 5 of the US Code. 

E Not releasable outside the US Government IAW Section 552(b)(1) of Title 5 
of the US Code. 

F Not releasable to foreign nationals and not releasable outside the US 
Government IAW Section 552(b)(1) of Title 5 of the US Code. 

H Releasable to soil country only; otherwise, not releasable outside the US 
Government IAW Section 552(b)(1) of Title 5 of the US Code. 

J Contingency Assignment - The record contains unified commander 
comments only; not releasable to foreign nationals unless formally 
coordinated; otherwise, not releasable outside the US Government IAW 
Section 552(b)(1) of Title 5 of the US Code. 

K Permanent assignment. Available for contingency use within the theater 
after coordination with and approval of the cognizant unified commander - 
releasable to soil nation; otherwise, not releasable outside the US 
Government IAW Section 552(b)(1) of Title 5 of the US Code. 

N Releasable to NATO; otherwise, not releasable outside the US Government 
IAW Section 552(b)(1) of Title 5 of the US Code. 

P Proprietary; otherwise, not releasable outside the US Government IAW 
Section 552(b)(1) of Title 5 of the US Code. 

 
The following special handling codes are used within TOP SECRET stand-alone 
databases and are not to be used within the FRRS worldwide SIPRNET database 
system:  

L Sensitive Compartmented Information (SCI); otherwise, not releasable 
outside the US Government IAW Section 552(b)(1) of Title 5 of the US 
Code. 

Q Special Category (SPECAT); otherwise, not releasable outside the US 
Government IAW Section 552(b)(1) of Title 5 of the US Code. 

R Special Access Required (SAR); otherwise, not releasable outside the US 
Government IAW Section 552(b)(1) of Title 5 of the US Code. 

 
Declassification Instructions  
 
For TOP SECRET, SECRET, CONFIDENTIAL records, provide the appropriate 
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declassification instruction using one of the following formats:  

DEYYYYMMDD Declassify on: Enter DE 
followed by the year (YYYY), 
the month (MM) and the day 
of the month (DD). If the 
declassification date set at the 
time of the original 
classification action is to be 
extended beyond 10 years, a 
data entry is required in Data 
Item 014. 

DEOADR Declassify on: Originating 
Agency Determination 
Required. If DEOADR is used 
in a record, an entry is required 
in Data Item 014.  
 
Examples:  
UE  
CB, DE20051130  
SE, DEOADR  

DEXnnnnnnn Declassify on: Exempt from 
automatic declassification. The 
letters nnnnnnn indicate one 
or more reasons (see list 
below) why TOP SECRET, 
SECRET, CONFIDENTIAL 
records cannot be 
automatically declassified. 
Enter DEX followed by one to 
seven numbers, in numerical 
order, applicable to the 
appropriate reason(s) listed 
below.  

1 Reveal an intelligence 
source, method, or 
activity, or a cryptologic 
system or activity. 

2 Reveal information that 
would assist in the 
development or use of 
weapons of mass 
destruction. 
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3 Reveal information that 
would impair the 
development or use of 
technology within a US 
weapons system. 

4 Reveal US military 
plans or national 
security emergency 
preparedness plans. 

5 Reveal foreign 
government information. 

6 Damage relations 
between the US and a 
foreign government, 
reveal a 
CONFIDENTIAL 
source, or seriously 
undermine diplomatic 
activities that are 
reasonably expected to 
be ongoing for a period 
greater than ten years. 

7 Impair the ability of 
responsible US 
government officials to 
protect the president, the 
vice president, and other 
individuals for whom 
protection services, in 
the interest of national 
security, are authorized. 

8 Violate a statute, treaty 
or international 
agreement.  
 
Examples:  
SH, DEX1    (one reason 
for exemption from 
automatic 
declassification)  
CJ, DEX134    (three 
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reasons for exemption 
from automatic 
declassification)  

 

DE25Xn Declassify on: Permanently 
valuable information (as 
defined by the national 
archivist) is exempt from 
automatic declassification 25 
years beyond the original 
classification date. (The letter 
n indicates why a TOP 
SECRET, SECRET, or 
CONFIDENTIAL record 
cannot be automatically 
declassified 25 years after the 
original classification date.) 
Enter DE25X followed by a 
number n from the applicable 
paragraph below. Note: When 
the value of n is greater than 1, 
an entry is required in Data 
Item 016.  

1 Reveal the identity of 
CONFIDENTIAL 
human source, or reveal 
information about the 
application of an 
intelligence source or 
method, or reveal the 
identity of a human 
intelligence source when 
the unauthorized 
disclosure of that source 
would clearly and 
demonstrably damage 
the national security 
interests of the US. 

2 Reveal information that 
would assist in the 
development or use of 
weapons of mass 
destruction. 
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3 Reveal information that 
would impair US 
cryptologic systems or 
activities. 

4 Reveal information that 
would impair the 
application of state-of-
the-art technology 
within a US weapon 
system. 

5 Reveal actual US 
military war plans that 
remain in effect. 

6 Reveal information that 
would seriously and 
demonstrably impair 
relations between the US 
and a foreign 
government, or seriously 
and demonstrably 
undermine ongoing 
diplomatic activities of 
the US. 

7 Reveal information that 
would clearly and 
demonstrably impair the 
current ability of US 
Government officials to 
protect the president, 
vice president, and other 
officials for whom 
protection services, in 
the interest of national 
security, are authorized. 

8 Reveal information that 
would seriously and 
demonstrably impair 
current national security 
emergency preparedness 
plans. 
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9 Reveal information that 
would violate a statute, 
treaty, or international 
agreement.  
 
Example:  
SH, DE25X5  

 

Maximum Input 
Length: 

2,10 characters. 

 

Input Requirement: 

Data Item 005 is always 
required. Enter the 
overall security 
classification of the 
frequency proposal or 
assignment and the 
appropriate special 
handling code if 
required. (OUS&P 
requests must have a 
special handling code 
included in the security 
classification. When 
applicable, each 
UNCLASSIFIED 
frequency assignment 
must have a special 
handling code so it can 
be identified as a record 
that has been separated 
from a 
CONFIDENTIAL group 
defined in the DOD 
Frequency Assignment 
Security Classification 
Guide.) As a security 
precaution, this data item 
cannot be deleted from a 
record and can only be 
changed by use of Data 
Item 006. 

 

Net Name JCEOI Master Net List Name. SFAF Data Item Number 983. Data Item 983 is 
the name entered in the JCEOI Master Net List in JACS. This is a required item for 
the JCEOI.  
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Maximum Input Length:   16 characters.  
 
Input Requirement:   Enter the name of the net the assigned frequency will 
support. Revised Battlefield Electronics CEOI System/Revised DTD (Data 
Transmission Device) Software (RBECS/RDS) will only support 16 characters. 
Common Tier Three (CT3) will only support 15 characters and will truncate the last 
character.  
 
Examples:  
CINC1  
JTF17  
3BDE CMD  

Net Type Describes the net's equipment type. MNL GENERAL has no associated equipment 
within ACES and is used to include the net in SOI. As components are installed 
beneath MNL, net types become available for selection by the operator that are 
related to the newly installed component.  
 
MNL GENERAL - This net type is used for nets that may require SOI assignments 
but will not be Crypto Generated to produce COMSEC key tag assignments. 
Therefore, platforms and equipments cannot be added to MNL GENERAL nets. 
For SOI frequency assignments, MNL GENERAL nets will receive only one 
frequency assignment.  
CNR SINCGARS - This net type is used for planning SINCGARS nets. When 
planning SINCGARS nets, the operator has the option to add or not add platforms 
and equipment. If downloading loadsets via distribution path, platforms and 
equipment are required. If manually creating loadsets, platforms and equipment are 
NOT required to Crypto Generate the net's COMSEC key tag assignment.  
CNR RATT - Radio Teletype net type used for planning division level HF Nets.  
CNR NRI - Net Radio Interface net type used for planning CNR to Mobile 
Subscriber Equipment (MSE) radio interface nets.  
CNR Common Use - Net type used to plan nets that have equipment participating 
in multiple frequency bands.  
CNR Non Secure - Net type used for planning non-secured networks. These net 
types cannot be crypto validated and generated.  

FRQ Frequency. SFAF Data Item Number 110. Data Item 110 is the frequency band 
or discrete frequency assigned to the unit and/or required for the equipment 
described in the assignment. A reference frequency, if included, is the assignment 
of a suppressed or reduced carrier sideband.  
 
Maximum Input Length:   11 or 11-11 or 11(11) characters.  
 
Input Requirement:   This data item is always required. Enter the discrete 
frequency or frequency band assigned to the unit and/or required for the equipment 
described in the assignment. A reference frequency, if included in parenthesis, is 
the assignment of a suppressed or reduced carrier sideband. For a frequency band 
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assignment, enter the lower frequency and the upper frequency (separated by a 
dash) with the frequency unit indicator preceding the lower frequency. An upper 
frequency range unit indicator is required if the units of the upper frequency range 
is different from the units of the lower frequency range, e.g. 110. K2000-M35. For 
certain operations, the assignment of a range of frequencies (frequency band) may 
be required in lieu of a specific operating frequency. These types of assignments 
shall only be requested when specific frequencies will not satisfy the requirements. 
Frequency band assignments are normally authorized for the following:  

a. Transmitters which automatically sweep through all frequencies in a band. 

b. Radiosonde transmitters operating in either of the bands: M400.15 - 406.0 or 
M1670 - 1700. 

c. Frequency-agile radar beacons (racon) operating in either of the bands: 
M2900 - 3100 or M9300 - 9500. 

d. Transmitters that use automatic frequency selection based on changing 
propagation conditions along the transmission path. 

e. Transmitters that automatically pause at 15 or more specific operating 
frequencies within a band. 

f. Operations that require the use of 15 or more specific operating frequencies 
within a band for Research, Development, Test and Evaluation (RDTE) 
purposes. 

g. Operations that involve a multitude of mobile radiolocation or 
radionavigation transmitters. Whenever possible, at the option of the 
applicant, operational frequencies may be recorded in Data Item 503. 

h. Tactical and/or training assignments (above 30 Megahertz (MHz)) that 
require the use of 15 or more specific operating frequencies within a band. 

i. Operations devoted exclusively to Electronic Warfare (EW), Electronic 
Countermeasures (ECM), and/or Electronic Counter-Countermeasures 
(ECCM). For sideband operations, enter the reference frequency in 
parentheses after the assigned frequency. 

 
Precede the frequency value with unit indicators as follows:  

K  if frequency is less than 30 MHz 

M  if frequency is at least 30 MHz, but less than 100GHz 

G  if frequency is at least 100 GHz, but less than 3THz 

T  if frequency is 3 THz or greater 
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Insert a decimal point only if there is a significant digit to the right of the decimal 
point.  
 
Examples:  
K17034  
K6737.5(6736)  
K2000-M30  
 
For frequency band(s) that are to be excluded from a given frequency band, enter 
the excluded bands in Data Item 111.  
 
Examples:  
M13250-15700  
M14770-14930  
 
Special Consideration for Processing Frequency Entries  
 
Frequency(ies), frequency bands, or reference frequencies listed in FRRS records 
cannot be changed. Frequency data is required (as part of a computer triple check of 
frequency (Data Item 110), record security classification (Data Item 005), and 
record serial number (Data Item 102)) to ensure that the correct record is being 
modified. Failure to enter the complete frequency, upper frequency limit, or 
reference frequency (Data Item 110) when using a Modification action is a frequent 
mistake that is overlooked during computer processing; however, mistakes made 
in entering the security classification of Data Item 110 are not overlooked 
during computer processing. The security classification of Data Item 110 is 
processed the same way as a data item being modified using a Modification action. 
For example, a modification input of 110. M9345 would change a record 
containing 110. (C)M9345-9465 to read 110. M9345-9465. In this example, the 
frequency data (M9345-9465) remained unchanged, but the classification of the 
frequency data was declassified from (C) to (U).  

FRQ 
BAND 

Frequency Band. See FRQ for information. 

XSC Transmitter State/Country. SFAF Data Item Number 300. Data Item 300 is an 
authorized abbreviation for the state, country, or geographical area in which the 
transmitting station is located. This data item cannot be changed in an FRRS record 
containing 144. Y.  
 
Maximum Input Length:   4 characters.  
 
Input Requirement:   This data item is required. Enter the name or standardized 
abbreviation of the state, country, or area in which the transmitting antenna is 
located.  
 
Examples:  
IN  
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LANT  
SPCE  

XAL Transmitter Antenna Location. SFAF Data Item Number 301. Data Item 301 is 
the name of the city, base, or geographical area of operation within which the 
transmitting antenna is actually located.  
 
Maximum Input Length:   24 characters.  
 
Input Requirement:   This data item is required. Enter the name of the city, base, 
or geographical area where the transmitter antenna is located. Abbreviate the data 
entry if necessary; however, if an abbreviation is not required, the entry should be 
spelled the same as that in the US postal zip code directory or applicable gazetteer. 
After being entered the first time, all future entries for that same location should be 
spelled the same. If the transmitter antenna location is the same as the entry in Data 
Item 300, the antenna location should be abbreviated using the same abbreviation as 
that entered in Data Item 300. In addition to the above, the following will apply:  

a. The following standard abbreviations will be used even if the entry is less than 24 
characters: 

Abbreviation Location Word 

ARPT Airport 

ARA Army Area 

CP Camp 

CY City 

CGD Coast Guard District 

CO County 

DI District 

DIV Division 

FT Fort 

IAP International Airport 

IS Island(s) 

LNB Large Navigational Buoy 

MT Mont, Monte, Mount(s) 
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MTN Mountain(s) 

MAP Municipal Airport 

PG Proving Ground(s) 

PT Point 

ST Saint 

 

b. If the location name exceeds 24 characters after applying the standard 
abbreviation(s) and the entry has not been previously used, then shorten the entry to 
24 characters and enter the full text in Data Item 801 for review by the assignment 
authority. 

If an area of operation is selected, it may be described as a radius, in kilometers, 
extending from a given location. For example, if an assignment is for transmission 
anywhere within a 50-kilometer radius of Dallas, then insert DALLAS in this data 
item and the radius in Data Item 306 (Authorized Radius). An area of operation 
may also be described by geographical coordinates. For example, if an assignment 
is for one or more land mobile stations operating south of 33 degrees north in the 
state of Arizona, then insert AZ in this data item and the coordinate data in Data 
Item 530 (Authorized Areas).  
 
An area of operation within several states may also be described in this data item as 
US or USA, with the included or excluded state being shown in Data Item 531 
(Authorized States). Similarly, US&P may be used if the area includes a possession. 
For locations described as an area of operation, note that operations might not occur 
in every square mile of the area selected and the area described might overlap into 
states not shown in Data Item 300 (State/Country).  
 
Although the data inserted shall normally be geographical names or descriptions, 
exceptions may be made for experimental operations, mobile operations where the 
state/country and antenna location data items are identical (such as 300. PAC, 301. 
PAC, etc.), and/or space operations. For an assignment to an experimental station, 
other than one in space, or to a mobile station having identical state/country and 
antenna location names, words such as AIRCRAFT, BALLOONS, or SHIPS may 
be used, as appropriate. For an assignment to a station aboard a geostationary 
satellite, insert GEOSTATIONARY. For an assignment to a station aboard a 
nongeostationary satellite, insert NONGEOSTATIONARY. For an assignment to a 
station located on a natural object in space, insert the name of the object, e.g., 
MOON.  
 
Examples:  
FT BRAGG  
NASHVILLE  
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NONGEOSTATIONARY  

STC Station Class. SFAF Data Item Number 113. Data Item 113 identifies the 
functional use of the assigned frequency at a particular transmitting station. See the 
Frequency Resource Record System (FRRS) Standard Frequency Action Format 
(SFAF), MCEB PUB 7, Annex A to Appendix A for a list of acceptable station 
class symbols and their definitions. The suffix R is included if a station is used 
primarily as a repeater and operates in the bands 29.89-50 (exclusive Government 
use), 138-144, 148-148.9, 150.05-150.8, 162-174, and 406.1-420 MHz.  
 
Maximum Input Length:   4 characters.  
 
Input Requirements: Enter one or more standard station class symbol(s). (Data 
items 113, 114, 115 and (116 for Europe only) are interrelated, and an entry in any 
of the three data items must be accompanied by a corresponding entry in the other 
data items.)  
 
Example:  
FX  

EMS Emission Designator. SFAF Data Item Number 114. Data Item 114 identifies the 
necessary bandwidth and emission classification symbols. The bandwidth can be 
determined by using formulas shown in the ITU Radio Regulation, CCIR 
Recommendations, or the NTIA Manual. Emission classification symbols consist of 
the three required symbols and the two optional symbols shown in Table A-B-1 and 
A-B-2 in Annex B to Appendix A of the Frequency Resource Record System 
(FRRS) Standard Frequency Action Format (SFAF), MCEB PUB 7.  
 
Maximum Input Length:   11 characters.  
 
Input Requirement: Enter one or more emission designator(s) containing the 
necessary bandwidth and the emission classification symbols. Enter the necessary 
bandwidth using the first four characters (three digits and a unit designator letter are 
required), with the unit designator in the position the decimal would normally 
occupy. Use:  

H If the value is less than 1000 Hz 

K 1 KHz to values less than 1000 KHz 

M 1 MHz to values less than 1000 MHz 

G 1 GHz or greater. 

 
 
A doppler shift shall not be included in the frequency tolerance or bandwidth of 
emission; however, when a doppler shift is significant, it should be reported in Data 
Item 520.  
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Example:  
3K00J3E  
 
See Appendix A to the Frequency Resource Record System (FRRS) Standard 
Frequency Action Format (SFAF), MCEB PUB 7 for more examples.  

PWR Transmitter Power. SFAF Data Item Number 115. Data Item 115 identifies the 
maximum transmitter power output authorized to be used.  
 
Maximum Input Length:   9 characters.  
 
Input Requirement: Enter one or more power data entries. Enter (1) carrier power 
(pZ) for A3E sound broadcasting in the broadcasting service, (2) mean power (pY) 
for other amplitude modulated emissions using unkeyed full carrier, and for all 
frequency modulated emissions, and (3) peak envelope power (pX) for all emission 
designators other than those referred to in (1) and (2) above, including C3F 
television (video only). Express the power to a maximum of five decimal places 
and precede the entry with the unit designator as follows:  

W If power is less than 1000 watts 

K If power is at least 1 KW but less than 1000 KW 

M If power is at least 1 MW but less than 1000 MW 

G If power is 1 GW or greater. 

 
Examples:  
W0.5  
K1.5  

User Operating Unit. SFAF Data Item Number 207. Data Item 207 indicates the name 
or designation of the organization using the frequency assignment.  
 
Maximum Input Length:   18 characters.  
 
Input Requirement: This data item is required. Enter the short name or 
designation of the organization using the frequency assignment. For 
CINCPACFLT: Enter ACFT and/or SHIPS when Data Item 300 equals PAC, 
LANT, INDO, etc.  
 
Examples:  
602TCW  
SUBRON18  
517ARTY  

XLL Transmitter Antenna Coordinates. SFAF Data Item Number 303. Data Item 
303 is the World Geodetic System 1984 (WGS 84) datum latitude and longitude 
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(expressed in degrees, minutes, and seconds) of the transmitter antenna location 
entered in Data Item 301.  
 
Maximum Input Length:   15 characters.  
 
Input Requirement: This data item is required except when the site named in Data 
Item 301 is an area of operation for which coordinates cannot be applied or for 
nongeostationary satellites. Enter geographical coordinates (degrees, minutes, and 
seconds) for the antenna location. If the seconds are not known, insert 00 for the 
seconds, except in the case of navigation aid system (NAVAIDS), geostationary 
satellites, and microwave facilities where seconds are required. Use leading zeros as 
appropriate for degrees, minutes, or seconds. Degrees latitude require two digits; 
degrees longitude require three digits. Enter N or S for latitude and E or W for 
longitude. If GEOSTATIONARY has been entered in Data Item 301, enter the 
latitude as 000000N and the longitudinal position of the satellite (in degrees, 
minutes, and seconds east or west). Note, when older maps are used, the 
coordinates may vary as much as 300-400 meters from locations determined by 
using DOD standard WGS 84 datum maps or Global Positioning System (GPS) 
equipment. Organizations are encouraged to obtain GPS equipment to determine 
the position of fixed antennas.  
 
Examples:  

214216N1171039W (Coordinates for a fixed location) 

000000N1750000E (Coordinates for a geostationary satellite) 
 

Xrad Transmitter Authorized Radius. SFAF Data Item Number 306. Data Item 306 
defines the area of operation for a portable, mobile, or transportable transmitter 
station. This area is expressed as a radius in kilometers extending from the 
geographical coordinates listed in Data Item 303.  
 
Maximum Input Length:   5 characters.  
 
Input Requirement: If the station is portable, mobile, and/or transportable, and a 
circular area is used to describe the area of operation, enter a radius (in kilometers) 
from the coordinates listed in Data Item 303 to describe the area in which the 
transmitter station will operate. And the suffix T to the entry if the radius applies 
only to the transmitter station, or B if the radius applies to both the transmitter and 
receiver stations (Note: When both fixed and mobile stations are to transmit on the 
same frequency, leave this data item blank and enter the radius of the mobile station 
id Data Item 406).  
 
Examples:  

150B (Indicates a 150-kilometer radius of operation for both transmitter and 
receiver stations) 
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30T (Indicates a 30-kilometer radius of operation for the transmitter) 
 

Xeqp Transmitter Equipment Nomenclature. SFAF Data Item Number 340. Data 
Item 340 has two parts. The first part identifies the type of equipment (government, 
commercial, or unassigned) and the second part identifies either the standard 
military nomenclature or the commercial make and model number of the equipment 
at each specific transmitter station location. If both a military nomenclature and a 
commercial model number are assigned to the same equipment, the military 
nomenclature will be used.  
 
Maximum Input Length:   1,18 characters.  
 
Input Requirement: This data item is required. Enter the equipment type code 
followed by the equipment system or component nomenclature for the transmitter 
location. (If available, the system nomenclature is preferred rather than the 
component nomenclature; however, either is acceptable. Data items 340 and 343 
are interrelated, and an entry in Data Item 340 should be accompanied by a 
corresponding entry in Data Item 343, if known.) Enter one of the following 
equipment type codes:  

G Government nomenclature 

C Commercial model number 

U Unassigned nomenclature 

 
After the equipment type code, enter a comma and then the nomenclature subject to 
the following:  

a. For a government equipment nomenclature, enter the standard military 
nomenclature.  
 
Examples:  

G,AN/GRC-103 (A system nomenclature) 

G,T128 (A transmitter component nomenclature) 
 

b. If only a commercial model number is available, indicate the manufacturer 
of the equipment, using the manufacturer's code listed in Annex D to 
Appendix A of the Frequency Resource Record System (FRRS) Standard 
Frequency Action Format (SFAF), MCEB PUB 7, followed by the model 
number. If no manufacturer code exists or is unknown, enter the full name of 
the manufacturer in Data Item 801.  
 
Example:  
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C,MOTH23FFN1130E (A commercial handie-talkie manufactured by 
Motorola, model number H23FFN1130E. A 
partial nomenclature such as MOTH23 is 
incomplete since it applies to several different 
models of Motorola handie-talkie. The 
manufacturer's name and the complete model 
number should be obtained from data plates on 
equipment whenever possible) 

 

c. If the nomenclature includes a modification, insert MOD and a number, if 
applicable, immediately following the nomenclature. For the word MARK, 
insert MK immediate following the nomenclature.  
 
Example:  
G,T238MK1  

d. If the transmitter does not have an assigned government nomenclature or 
commercial model number, enter the manufacture's name and a brief 
description of the equipment listed in Data Item 801.  
 
Examples:  

COLLINS RADIO EXPERIMENTAL 

RADAR 
 

 

RSC Receiver State/Country. SFAF Data Item Number 400. Data Item 400 is an 
authorized abbreviation for the state, country, or geographical area in which the 
receiving station is located. The approved list of abbreviations are listed in Annex C 
to Appendix A of the Frequency Resource Record System (FRRS) Standard 
Frequency Action Format (SFAF), MCEB PUB 7.  
 
Maximum Input Length:   4 characters.  
 
Input Requirement: This data item is required. Enter the name or abbreviation of 
the state, country, or area in which the receiving antenna is located.  
 
Example A:  

NC (a single or first occurrence for a receiver) 

 
Example B:  

TN,R01 (an example of two receivers) 

SPCE,R02  
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RAL Receiver Antenna Location. SFAF Data Item Number 401. Data Item 401 is the 
name of the city, base, or geographical area of operation within which the receiving 
antenna is actually located.  
 
Maximum Input Length:   24 characters.  
 
Input Requirement: This data item is required. Enter the name of the city, base, or 
geographical area where the receiver antenna is located. Abbreviate the date entry if 
necessary; however, if an abbreviation is required, the entry should be spelled the 
same as that in the US Postal Zip Code Directory or applicable gazetteer. After a 
name has been entered the first time, all future entries for that same location should 
use the same spelling. If the receiver antenna location is the same as the entry in 
Data Item 400, the antenna location will be abbreviated using the same abbreviation 
entered in Data Item 400.  

a. In addition to the above, the following standard abbreviations will be used even if 
the entry is less than 24 characters. 

Abbreviation Location Word 

ARPT Airport 

ARA Army Area 

CP Camp 

CY City 

CGD Coast Guard District 

CO County 

DI District 

DIV Division 

FT Fort 

IAP International Airport 

IS Island(s) 

LNB Large Navigational Buoy 

MT Mont, Monte, Mount(s) 

MTN Mountain(s) 
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MAP Municipal Airport 

PG Proving Ground(s) 

PT Point 

ST Saint 

 

b. If the location name exceeds 24 characters after applying the standard 
abbreviation(s) and the entry has not been previously used, then shorten the entry to 
24 characters and enter the full text in Data Item 801 for review by the assignment 
authority. 

If an area of operation is involved, it may be described as a radius, in kilometers, 
extending from a given location. For example, if an assignment is for transmission 
anywhere within a 50-kilometer radius of Dallas, then insert DALLAS in this data 
item and the radius in Data Item 306 (Authorized Radius). An area of operation 
may also be described by geographical coordinates. For example, if an assignment 
is for one or more land mobile stations operating south of 33 degrees north in the 
state of Arizona, then insert AZ in this data item and the coordinate data in Data 
Item 530 (Authorized Areas).  
 
An area of operation within several states may also be described in this data item as 
US or USA, with the included or excluded state being shown in Data Item 531 
(Authorized States). Similarly, US&P may be used if the area includes a possession. 
For locations described as an area of operation, note that operations might not occur 
in every square mile of the area selected and the area described might overlap into 
states not shown in Data Item 300 (State/Country).  
 
While the data inserted shall normally be geographical names or descriptions, 
exceptions may be made for experimental operations, mobile operations where the 
state/country and antenna location data items are identical (such as PAC PAC, etc.), 
and/or space operations. For an assignment to an experimental station, other than 
one in space, or to a mobile station having identical state/country and antenna 
location names, words such as AIRCRAFT, BALLOONS, or SHIPS may be used, 
as appropriate. For an assignment to a station aboard a geostationary satellite, insert 
GEOSTATIONARY. For an assignment to a station aboard a nongeostationary 
satellite, insert NONGEOSTATIONARY. For an assignment to a station located on 
a natural object in space, insert the name of the object, e.g., MOON.  
 
Examples:  
FT BRAGG  
NASHVILLE,R05  
NONGEOSTATIONARY  

RLL Receiver Antenna Coordinates. SFAF Data Item Number 403. Data Item 403 is 



 38

the WGS 84 datum latitude and longitude (expressed in degrees, minutes, and 
seconds) of the receiver antenna location(s) entered in Data Item 401.  
 
Maximum Input Length:   15 characters.  
 
Input Requirement: This data item is required except when the site named in Data 
Item 401 is an area of operation for which coordinates cannot be applied or for 
nongeostationary satellites. Enter geographical coordinates (degrees, minutes, and 
seconds) for the antenna location. If the seconds are not known, insert 00 for the 
seconds, except in the case of NAVAIDS, geostationary satellites, and microwave 
facilities where seconds are required. Use leading zeros as appropriate for degrees, 
minutes, or seconds. Degrees latitude require two digits; degrees longitude require 
three digits. Enter N or S for latitude and E or W for longitude. If 
GEOSTATIONARY has been entered in Data Item 401, enter the latitude as 
000000N and the longitudinal position of the satellite (in degrees, minutes, and 
seconds east or west). Note, when older maps are used, the coordinates may vary as 
much as 300-400 meters from locations determined by using DOD standard WGS 
84 datum maps or Global Positioning System (GPS) equipment. Organizations are 
encouraged to obtain GPS equipment to determine the position of fixed antennas.  
 
Examples:  

422615N1263228W 

000000N0925300W 
 

Rrad Receiver Authorized Radius. SFAF Data Item Number 406. Data Item 406 
defines the area of operation for a portable, mobile, or transportable receiver 
station. This area is expressed as a radius in kilometers extending from the 
geographical coordinates listed in Data Item 403.  
 
Maximum Input Length:   4 characters.  
 
Input Requirement: If Data Item 306 is blank and the receiving station is portable, 
mobile, or transportable and a circular area is used to describe the area of operation, 
enter the radius (in kilometers from the coordinates entered in Data Item 403) to 
describe the area in which the receiving station will operate. (Note: When both 
fixed and mobile stations transmit on the same frequency, an entry in Data Item 406 
indicates that the mobile station will be operating within the area described).  
 
Example:  
250  

Text Agency Free-Text Comments. SFAF Data Item Number 503. Data Item 503 is 
used to record agency remarks in the applications processed through the IRAC. 
These remarks will, therefore, be included in the GMF.  
 
Maximum Input Length:   35 characters.  
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Example:  
USAF AND USN SPONSORED.  
 
Flight levels are required by FAA coordination of frequency assignments within the 
US&P. Flight level data will be entered in hundreds (100s) of feet. The data entry 
will be formatted as: FL (followed by three digits). Leading zeros are required.  
 
Examples:  

FL160 (This means 16,000 feet.) 

FL035 (This means 3,500 feet.) 
 

Proj Name Exercise Project. SFAF Data Item Number 910. Data Item 910 provides the 
Project or Exercise name associated with a temporary assignment or proposal.  
 
Maximum Input Length:   20 characters.  
 
Input Requirement: This data item is optional.  
 
Example:  
GUARDRAIL  

JRFL Joint Restricted Frequency List (JRFL) Protection Code. SFAF Data Item 
Number 985. Data Item 985 may have two elements. The first element contains the 
JRFL protection code that is applicable to the frequency assigned to this net. The 
first data element is followed by a slash and a locally assigned priority code. (Note 
when this data item is blank the frequency assigned to this net will not be included 
in the JRFL.  
 
Maximum Input Length:   1 or 1/2 (1 slash 2) characters.  
 
Input Requirement: If the frequency assigned to this net is to be included in the 
JRFL, enter the protection code from the list below that was requested for the 
corresponding master net list entry. If required, then enter a slash followed by the 
assigned priority code.  

T Taboo. Safety of life, stop buzzer, etc. If priorities are used, Taboo should 
always be A1. 

G Guarded. Frequencies with interest to the Intelligence sections. 

P Protected. Frequencies that have importance to the operation, but may be 
jammed because of geographic or time separation. 

 
 
The locally assigned priority code consists of a letter followed by a number in the 
range A1 through Z9, with A1 being the highest.  
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Examples:  
T  
G/F2  
P/A4  

AGN Agency. SFAF Data Item Number 200. Data Item 200 identifies the agency 
responsible for managing the frequency assignment. Within the DOD this is 
normally USA, USN, USAF, or NSA. If an assignment is in joint use by two or 
more agencies, then both Data Items 147 and 200 must be completed. The 
responsible DOD agency will be entered as the first data entry in Data Item 147 
followed by the other joint agencies. For example, an assignment between USAF 
and NASA would be entered as 147. USAF, 147/2. NASA and 200. JNTSVC.  
 
Maximum Input Length:   6 characters.  
 
Input Requirement: Enter one of the following service or agency abbreviations as 
appropriate: USA, USN, USAF, NSA, or JNTSVC. If JNTSVC is entered, Data 
Item 147 must be completed.  
 
Example:  
USA  

FRQ Sep Frequency Separation Criteria. SFAF Data Item Number 112. Data Item 112 
identifies the required frequency separation between the different radio sets 
operated at one transmitter or receiver location.  
 
Maximum Input Length:   35 characters.  
 
Input Requirement: Data Item 112 is required for USCINCEUR assignments. It is 
optional for all others. Enter the required frequency separation ()F), in MHz, 
between the different radio sets operated at one location.  

0.5 MHZ For a transmitter power below 24.8 dBW (300 watts), enter 0.5 
MHz 

2 MHZ For a transmitter power above 24.8 dBW (300 watts), enter 2 
MHz 

2.0 - 9.9 
MHZ 

For an exceptionally high transmitter powers, enter values 
between 2.0 MHz and 9.9 MHz. 

 
If radio sets have two or more power stages, enter the dBW value and )F for each 
power stage. Note: This data is required in order to avoid desensitizing the receivers 
if two or more UHF radio sets are operated at one location simultaneously, e.g., at a 
tower. This data also is required to establish the prerequisites for an interference-
free radio communication.  
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If, in radio relay frequency requests, a minimum frequency separation between a 
number of transmitters or between a transmitter and a receiver must be observed, 
these separation frequencies are to be entered. Enter the value in MHz. Use the 
following abbreviations and separate them with slashes:  
 
TX - Transmitter  
RX - Receiver   

Examples: 

0.5 MHZ 

2.0 MHZ 

TX/TX40MHZ/TX/RX100MHZ 

Coord Coordination Indicator. SFAF Data Item Number 151. Data Item 151 indicates 
whether the IRAC is to coordinate the application with the Canadian Government, 
the Mexican Government, or both. It is also used for EUCOM assignments 
coordinated with NATO or host nations, or both.  
 
Maximum Input Length:   1 character.  
 
Input Requirement: For assignments near US borders, enter one of the following 
codes:  

C Coordinated with Canada 

M Coordinated with Mexico 

B Coordinated with both Canada and Mexico 

 
For EUCOM and Atlantic Command (LANTCOM) assignments, enter one of the 
following codes:  

M Coordinated with NATO for inclusion in the Master Radio Frequency List 
(MRFL) 

H Coordinated with Host Nation 

B Coordinated with both NATO and Host Nation 

 
Example:  
C  
 
The coordination indicator is also used to identify the US Government coordination 
channels for those Canadian assignments along the US/Canada border that have 
been included in the GMF for EMC analysis purposes:  
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D Coordinated through NTIA with FAS member agencies 

F Coordinated through FAA 

J Coordinated through the DOD's Joint Chiefs of Staff (JCS) 

U No indication of coordination. 
 

NATO 
Pool 

NATO Pooled Frequency Code Number. SFAF Data Item Number 505. Data 
Item 505 provides data on communications associated with ground 
transmitters/receivers as well as aircraft operating in the 225-400 MHz frequency 
band.  
 
Maximum Input Length:   5 characters.  
 
Input Requirement: Data Item 505 is required for CINCEUR and USACOM 
assignments. For air/ground/air and air to air requirements in the 225-400 MHz 
band, enter a Type Special Assignment code. Use of this data item is optional for all 
other bands.  

Code Type Special Assignment 

B air/ground/air requirements 

A air to air requirements 

P air/ground/air pool requirement 

 
 
Upon approval of USCINCEUR assignments only, the Frequency Management 
Subcommittee (FMSC) will assign, from the groupings below, a code number 
identifying the type and nationality of a frequency pool:  

0001-0199 United States 

0700-0999 Special Operations Pools 

2000-2299 Command and Miscellaneous Pools 

 
Example data input:  
P  
 
Example of data returned from FMSC:  
P0803  

Guard Guard Requirement. SFAF Data Item Number 999. Data Item 999 is a listing of 
organizations required to guard (monitor) the net.  
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Maximum Input Length:   20 characters.  
 
Input Requirement: Enter organizations required to guard this net, if any.  
 
Examples:  
JTF CMD CTR  
MARFOR CMD CTR  
AFFOR CMD CTR  
G-NMZ,TR,CV8  

Rad Tun Transmitter Radar Tunability. SFAF Data Item Number 345. Data Item 345 is 
a coded entry describing the tuning capabilities of both pulsed and nonpulsed 
radars.  
 
Maximum Input Length:   2 characters.  
 
Input Requirement: For all radars, enter one of the following symbols:  

FA Frequency-agile radars that operate on various frequencies within a band, 
either specified or random mode 

FV Radars that operate on a discrete frequency determined by the 
characteristics of a fixed magnetron or similar radio frequency generating 
device 

FX Radars capable of operating on a single discrete frequency 

TC Radars capable of being tuned to any frequency within the requested band 

TS Radars capable of being tuned across the authorized or requested band in 
discrete steps or increments. This includes crystal control. 

 
Example:  
TC  

Org Code Organization Code. A number from 1 to 99 that separates the nets into 
organizations as determined by the operator. For SINCGARS nets, no more than 
1000 nets and no more than 100 nets with the same hundreds grouping may be in 
the same Organization Code. 

Net ID Net ID. This Net ID is used when the Net Type is SINCGARS. To fix a 
SINCGARS Net ID, type the 3-digit Net ID into the MNL. To ensure a Net ID is 
assigned to a net for a specific hundreds grouping during the SOI generation, enter 
the number followed by 'XX' (i.e., '3XX'). To assign a random SINCGARS Net ID 
during the SOI generation, enter 'XXX'. 

Chnl Spc Channel Spacing. Channel Spacing is used to determine the raster increments of an 
SOI frequency that can be assigned to the net. The Channel Spacing is in the SFAF 
Frequency format. 

Cue Upper Cue Upper Limit. Cue Upper Limit is used to limit the Cue frequency assignment 
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Limit for a SINCGARS net. During the SOI frequency assignment, the SINCGARS net 
will not receive a Cue assignment greater than the one specified in the field. The 
Manual frequency assignment is limited by the FRQ BAND attribute for the net. 
The Cue Upper Limit is in the SFAF Frequency format. 

Reuse Cls Reuse Class. Reuse Class specifies all Reuse Zones with the Reuse Class will use 
the same set of frequencies during the SOI frequency assignment. Reuse Class is 
described by a number from 1 to 99. 

Resue Zn Reuse Zone. Each net within a Reuse Zone may not be allocated the same 
frequency as any other net with the same Class and Zone for any one time period. 
The format of a Reuse Zone is described by a number from 1 to 99. 

C/S Net Tactical Call Sign. SFAF Data Item Number 987. Data Item 987 is the 
tactical Call Sign assigned to the net. A Call Sign is defined as any combination of 
alphanumeric characters or phonetically pronounceable characters (trigraph), which 
identifies a communications facility, a command, an authority, an activity or unit; 
used primarily for establishing and maintaining communications.  
 
Call Sign is used by the SOI generation function to determine Call Sign 
requirement for the net. Enter 'Y' for a randomly assigned Call Sign. Enter 'N' for 
no Call Sign assignment. Enter 'Letter-Number-Letter' for a fixed Call Sign (i.e., 
'N3Y').  
 
Maximum Input Length:   3 characters.  
 
Input Requirement: Enter 'Y' if requesting a tactical Call Sign. The Call Sign will 
be assigned by JACS, if requested.  
 
Example:  
Y  

C/W Net Tactical Call Word. SFAF Data Item Number 986. Data Item 986 is the 
tactical Call Word assigned to the net. A tactical Call Word is defined as a 
pronounceable word that identifies a communications facility, a command, an 
authority, an activity, or a unit.  
 
Call Word is used by the SOI generation function to determine call word 
requirement for the net.  
 
Maximum Input Length:   15 characters.  
 
Input Requirement: Enter the Call Word directly into the MNL to fix the Call 
Word for the net or select the dictionary from which the SOI call word assignment 
function will assign a Call Word. Dictionaries are identified on the MNL by being 
placed between "[]".  

24HR 24 Hours Call Word Protection. If selected, the Call Word assigned to the net will 
not be assigned to any other net in adjacent time periods of the SOI edition. 

EP ID Electronic Protection Identifier. All nets within an EPID share the same Hopset 
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resource and TSK. Valid ranges for an EPID are 1 to 99. 

Restore Net Restoral Priority. SFAF Data Item Number 991. Data Item 991 is the 
restoral priority assigned to the net. The first character identifies the type of 
network, and the second and third numbers prioritize the net within that type of 
network (as defined in APP-4). This priority will be established by the JTF 
commander.  
 
Maximum Input Length:   3 characters.  
 
Input Requirement: Enter the restoral priority of the net, if any.  
 
Examples:  
H15  
A01  

Keymat COMSEC Keymat. SFAF Data Item Number 995. Data Item 995 contains the 
short title of the communications security (COMSEC) keying material (Keymat) 
that is used for the net.  
 
Maximum Input Length:   15 characters.  
 
Input Requirement: Enter the COMSEC Keymat for the net, if required.  
 
Examples:  
USKAT 619  
USKAT 3120  

User Code User Net/Code. SFAF Data Item Number 208. Data Item 208 is a unique code 
that identifies the specific user of the frequency, i.e., the command, activity, unit, 
project, etc.  
 
Maximum Input Length:   6 characters.  
 
Input Requirement: Enter codes as directed by the responsible agency, as follows: 

Army Enter one Net Control Code. 

Navy Enter the one Unit Identification Code (UIC) of either the operating 
unit identified in Data Item 207 or in Data Item 302. 

Air 
Force 

Enter a standard use code as directed by Air Force Frequency 
Management Agency. 

 
 
Examples:  
N53618  
ACEUS  

CRKT Circuit Type, Line Item, Group Category. SFAF Data Item Number 996. Data 
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Item 996 contains the Circuit Type (first two alpha characters), Line Item (next 
three digits), and Group Category (last three alpha numeric positions).  
 
Maximum Input Length:   8 characters.  
 
Input Requirement: Enter the Circuit Type, Line Item, and Group Category for 
the net, if required.  
 
Examples:  
AO4ZA1  
ED1253HO3  

Line Line Item. SFAF Data Item Number 996. See CRKT. 

Group Group Category. SFAF Data Item Number 996. See CRKT. 

Usage Band Usage. SFAF Data Item Number 993. Data Item 993 is the Band Usage of 
the net, if required. This character defines the frequency band label the net uses.  
 
Maximum Input Length:   1 character.  
 
Input Requirement: Enter the corresponding Band Usage of the net, if required.  
 
H - Hertz  
K - KiloHertz  
M - MegaHertz  
 
Examples:  
K  
M  

Notes Net Notes. SFAF Data Item Number 998. Data Item 998 contains the Net Notes 
associated with any Special Instructions (SPECINST).  
 
Maximum Input Length:   3 characters.  
 
Input Requirement: Enter the corresponding abbreviation for the SPECINST, if 
required. If this data item is to be used, Data Item 997 must contain SPECINST.  
 
Examples:  
Y11  
AA1  

Spc Inst JCEOI Special Net Instructions. SFAF Data Item Number 997. Data Item 997 
contains any special instructions applicable to the net.  
 
Maximum Input Length:   63 characters.  
 
Input Requirement: Enter any applicable special instructions pertaining to the net 
listed in data item 983, JCEOI Master Net List Name.  
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Examples:  
AOR WIDE SAR EXERCISE OPERATIONS  
SPECINST  

TAD Net Tactical Air Designator. SFAF Data Item Number 988. Data Item 988 is the 
TAD assigned to the net. A tactical air designator is a series of alphanumeric 
characters that can be used to identify frequencies and nets. These designators are 
usually listed in the Air Tasking Order (ATO) to prevent inadvertent disclosure of 
classified information.  
 
Maximum Input Length:   5 characters.  
 
Input Requirement: Enter the TAD, if known.  
 
Examples:  
3  
115  

Clr/W Net Color Word. SFAF Data Item Number 989. Data Item 989 is the Color 
Word assigned to the net. A tactical color word is a series of alpha characters that 
can be used to identify frequencies and nets. These words are usually listed in the 
Air Tasking Order (ATO) to prevent inadvertent disclosure of classified 
information.  
 
Maximum Input Length:   16 characters.  
 
Input Requirement: Enter the Color Word, if known. This item must contain 
information if data is entered in Data Item 990 Color Number.  
 
Examples:  
BLUE  
ORANGE  

Clr/Num Net Color Number. SFAF Data Item Number 990. Data Item 990 contains a two 
digit Color Number assigned to the net. These numbers are usually listed in the Air 
Tasking Order (ATO) to prevent inadvertent disclosure of classified information.  
 
Maximum Input Length:   2 characters.  
 
Input Requirement: Enter the Color Number, if known. A leading zero is required 
for numbers less than ten. This data item must contain information if data is entered 
in data item 989 Color Word.  
 
Examples:  
22  
03  

Push Net Push Number. SFAF Data Item Number 992. Data Item 992 is the Push 
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Number assigned to the net. A push number is a series of alpha characters assigned 
to a frequency to assist the aircrew in moving to an alternate frequency.  
 
Maximum Input Length:   3 characters.  
 
Input Requirement: Enter the Push Number of the net, if any.  
 
Examples:  
15  
123  

Reuse Pri Reuse Priority. Reuse Priority is used by the operator to specify the ability level of 
a net to be used in a Frequency Reuse Group. Valid range is from 1 to 5 (1 indicates 
a net that can most be used in a Reuse Group and 5 is the least able to be used in a 
Reuse Group). 

XORBIN Transmitter Equatorial Inclination Angle. SFAF Data Item Number 315. Data 
Item 315 indicates the angle at which the transmitting NONGEOSTATIONARY 
satellite's orbit crosses the equator. A nongeostationary satellite is defined as one 
whose circular orbit does not lie in the plane of the earth's equator and has a 
specific equatorial inclination, apogee, and perigee.  
 
Maximum Input Length:   4 characters.  
 
Input Requirement: Enter an equatorial inclination angle (in degrees), using a 
decimal point for fractional degrees for nongeostationary space transmitter stations. 
 
Example:  
34.7  

XORBAP Transmitter Apogee. SFAF Data Item Number 316. Data Item 316 indicates the 
point in the orbit of a NONGEOSTATIONARY satellite at which it is farthest from 
the earth.  
 
Maximum Input Length:   5 characters.  
 
Input Requirement: Enter apogee (in kilometers) for nongeostationary space 
transmitter stations.  
 
Example:  
23500  

XORBPE Transmitter Perigee. SFAF Data Item Number 317. Data Item 317 indicates the 
point in the orbit of a NONGEOSTATIONARY satellite at which it is nearest to 
earth.  
 
Maximum Input Length:   5 characters.  
 
Input Requirement: Enter perigee (in kilometers) for nongeostationary space 
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transmitter stations.  
 
Example:  
200  

XORB Transmitter Period of Orbit. SFAF Data Item Number 318. Data Item 318 
indicates the time it takes for a NONGEOSTATIONARY transmitter satellite to 
make one complete orbit.  
 
Maximum Input Length:   7 characters.  
 
Input Requirement: Enter the period of orbit for nongeostationary space 
transmitter stations. If the period of orbit is less than 24 hours, enter the time in 
hours followed by the letter H. If it is 24 hours or more, enter the number of days, 
followed by the letter D. Enter the data, using a decimal point for a fractional unit.  
 
Example:  
19.6H  

XORBNR Transmitter Number of Satellites. SFAF Data Item Number 319. Data Item 
Number 319 indicates the number of NONGEOSTATIONARY satellite 
transmitters in a system having similar orbital characteristics.  
 
Maximum Input Length:   2 characters.  
 
Input Requirement: Enter the number of nongeostationary satellites in the system. 
 
Example:  
1  

XSPD Transmitter Power Density. SFAF Data Item Number 321. Data Item 321 
indicates the maximum power density, per hertz (in dBW), supplied to an earth or 
space station's antenna or to those of terrestrial stations (including experimental) 
employing earth or space station techniques. For frequencies below 15GHz, the 
power shall be averaged over the worst 4 KHz band; for frequencies 15 GHz and 
above, the power shall be averaged over the worst 1 MHz band. The worst 4 KHz 
and 1MHz bands are defined as those having the highest power density within the 
assigned emission bandwidth.  
 
Maximum Input Length:   4 characters.  
 
Input Requirement: For earth, space, or terrestrial stations (including 
experimental stations) employing earth or space station techniques, insert the 
maximum power density per Hz (in dBW) supplied to the antenna. For negative 
values, insert a minus sign (-) before the value.  
 
Example:  
8  



 50

RORBIN Receiver Equatorial Inclination Angle. SFAF Data Item Number 415. Data 
Item 415 indicates the angle at which the nongeostationary receiving satellite's orbit 
crosses the equator. A nongeostationary satellite is defined as one whose circular 
orbit does not lie in the plane of the earth's equator and that has a specific equatorial 
inclination, apogee, and perigee.  
 
Maximum Input Length:   4 characters.  
 
Input Requirement: Enter an equatorial inclination angle (in degrees) for 
nongeostationary space receiver stations.  
 
Example:  
34.7  

RORBAP Receiver Apogee. SFAF Data Item Number 416. Data Item 416 indicates the 
point in the orbit of a nongeostationary receiver satellite at which it is farthest from 
the earth.  
 
Maximum Input Length:   5 characters.  
 
Input Requirement: Enter apogee (in kilometers) for nongeostationary space 
receiver stations.  
 
Example:  
23100  

RORBPE Receiver Perigee. SFAF Data Item Number 417. Data Item 417 indicates the 
point in the orbit of a nongeostationary receiver satellite at which it is nearest to 
earth.  
 
Maximum Input Length:   5 characters.  
 
Input Requirement: Enter perigee (in kilometers) for nongeostationary space 
receiver stations.  
 
Example:  
200  

RORB Receiver Period of Orbit. SFAF Data Item Number 418. Data Item 418 indicates 
the time it takes for a nongeostationary receiver satellite to make one complete 
orbit. 
 
Maximum Input Length:   7 characters.  
 
Input Requirement: Enter the period of orbit for nongeostationary space receiver 
stations. If the period of orbit is less than 24 hours, enter the time in hours followed 
by the letter H. If it is 24 hours or more, enter the number of days, followed by the 
letter D. Enter the data, using a decimal point for a fractional unit.  
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Example:  
19.6H  

RORBNR Receiver Number of Satellites. SFAF Data Item Number 419. Data Item 
Number 419 indicates the number of nongeostationary receiving satellite in a 
system having similar orbital characteristics.  
 
Maximum Input Length:   2 characters.  
 
Input Requirement: Enter the number of nongeostationary satellites in the system. 
 
Example:  
24  

RSNT Space Station Noise Temperature. SFAF Data Item Number 470. Data Item 470 
denotes the noise temperature of the receiving space stations.  
 
Maximum Input Length:   4 characters.  
 
Input Requirement: Data Item 470 is required only for a space station(s). Enter 
the space station noise temperature in degrees Kelvin.  
 
Example:  
200,R02  

RRNT Earth Station System Noise Temperature. SFAF Data Item Number 471. Data 
Item 471 denotes the noise temperature of the receiving earth station(s).  
 
Maximum Input Length:   4 characters.  
 
Input Requirement: Data Item 471 is required only for a receiving earth station(s). 
Enter the earth-station system noise temperature in degrees Kelvin.  
 
Example:  
60,R02  

RENT Equivalent Satellite Link Noise Temperature. SFAF Data Item Number 472. 
Data Item 472 denotes the nose temperature at the input of the earth-stations 
receiver corresponding to the radio-frequency noise power that produces the total 
observed noise at the output of the satellite link. This excludes noise due to 
interference coming from satellite links using other satellites and from terrestrial 
systems.  
 
Maximum Input Length:   4 characters.  
 
Input Requirement: This entry is required for each earth station that receives 
signals from a geostationary space station using a simple frequency changing 
transponder. Enter noise temperature in degrees Kelvin, taking into consideration 
all satellite links received by the earth station on the frequency indicated.  
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Example:  
96,R03  

FRQ 
Share 

Frequency Share Group. All nets within a frequency share group will be assigned 
the same frequency during the SOI frequency generation process. 

C/W Share Call Word Share Group. All nets within a call word share group will be assigned 
the same frequency during the SOI frequency generation process. 

C/S Share Call Sign Share Group. All nets within a call sign share group will be assigned the 
same frequency during the SOI frequency generation process. 

COMSEC 
Class 

COMSEC Classification. COMSEC Classification is used by the operator to 
specify the classification of data that is to be transmitted across the net. When 
COMSEC key tags are generated for the net, the same classification specified here 
will be assigned to the key tag. 

Platform 
KEK 

Platform KEK. If COMMON KEK is selected, the platforms and equipment 
assigned to that net will receive the net's KEK designator. If UNIQUE KEK is 
selected, then each platform and equipment assigned to that net will receive its own 
unique KEK designator. 

Net Status Net Status. Displays the net's COMSEC key tag generation status. 

TEK 
Share 

TEK Share Group. All nets within a TEK share group will be assigned the same 
TEK designator. 

KEK 
Share 

KEK Share Group. All nets within a KEK share group will be assigned the same 
KEK designator. 

TEK TEK Designator. The TEK Designator that is assigned to the net by the ACES 
COMSEC key tag generation function. 

KEK KEK Designator. The KEK Designator that is assigned to the net by the ACES 
COMSEC key tag generation function. 

ICOM 
Hopset 

ICOM Hopset Designator. ICOM Hopset Designator used by this net for Hopset 
fill. Assigned by ACES. 

NonICOM 
Hopset 

Non ICOM Hopset Designator. Non ICOM Hopset Designator used by this net 
for Hopset fill. Assigned by ACES. 

Status 
Date 

Net Status Date. The date which the current net status was generated. 
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